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Abstract— Experimental modal analysis (EMA) is an 

accepted methodology for identifying modal parameters of 

complex system assemblies, but large channel counts and 

multiple references are usually required to perform a thorough 

modal survey of such structures. In these cases, modal testing 

can become very costly and time consuming. Moreover, success 

in accurately defining all the modes of interest from 

experimental data depends on a variety of factors, including 

how and where the excitation is applied, how and where 

measurement data is acquired, and how boundary conditions or 

other environmental conditions are simulated. This presentation 

suggest a methodology for virtual experimental modal analysis 

(VEMA). 

I.  INTRODUCTION 

Experimental modal analysis has grown steadily in 

popularity since the advent of the digital FFT spectrum 

analyser in the early 1970’s. Today, impact testing (or bump 

testing) has become widespread as a fast and economical 

means of finding the modes of vibration of a machine or 

structure. Modes are used as a simple and efficient means of 

characterizing resonant vibration. The majority of structures 

can be made to resonate. That is, under the proper conditions, 

a structure can be made to vibrate with excessive, sustained, 

oscillatory motion. Resonant vibration is caused by an 

interaction between the inertial and elastic properties of the 

materials within a structure. Resonant vibration is often the 

cause of, or at least a contributing factor to many of the 

vibration related problems that occur in structures and 

operating machinery. 

 
To better understand any structural vibration problem, the 

resonances of a structure need to be identified and quantified. 

A common way of doing this is to define the structure’s 

modal parameters. Modes (or resonances) are inherent 

properties of a structure. Resonances are determined by the 

material properties (mass, stiffness, and damping properties), 

and boundary conditions of the structure. Each mode is 

defined by a natural (modal or resonant) frequency, modal 

damping, and a mode shape. If either the material properties 

or the boundary conditions of a structure change, its modes 

will change. At or near the natural frequency of a mode, the 

overall vibration shape (operating deflection shape) of a 

machine or structure will tend to be dominated by the mode 

shape of the resonance. 

 

 The initial step in experimental modal analysis is to obtain 

the response of a structure to a certain kind of excitation. This 

might be accomplished under operational conditions or from 

modal testing within a controlled test environment. Once the 

response measurement has been completed, the next step to 

be performed is the identification of the modal parameters of 

the structure from the measured data. For this task a broad 

range of modal analysis techniques have been developed over 

the past decades. The decision which technique to apply in a 

given situation is to be based on diverse considerations, the 

most important of which are: Is the excitation known (which 

is generally the case in experimental modal analysis) or 

unknown (which is generally the case in operational modal 

analysis where the response of the structure to an ambient 

excitation under operational conditons is measured)? Is the 

data available just in the frequency domain or also in the time 

domain? Does a reasonable estimation of the parameters exist 

as a starting point for an iterative procedure to improve the 

initial guess? Are the structural modes well seperated or 

closely spaced? Is it reasonable to assume a lightly damped 

structure? 

 
There are several critera for the classification of modal 

analysis techniques. He and Fu distinguish between single-
degree-of-freedom (SDoF) and multi-degree-of-freedom 
(MDoF) methods [7]. Natke classifies modal analysis 
techniques as either phase resonance methods or phase 
separation methods [8]. Phase resonance methods are based on 
an adaption of the excitation in such a way that only one 
single mode is excited which simplifies the post-processing of 
the thus obtained data quite a lot but is experimentally very 
extensive. Phase separation methods on the other hand shift 
most of the effort to the post-processing of the data as quite 
elaborate and computationally expensive numerical methods 
are required to extract reliable modal information from data 
comprising the coexistent contribution of several modes. The 
most widely-used classification however distinguishes 
between frequency domain methods and time domain 
methods. The following list gives an overview of some 
popular modal analysis techniques as presented in [7],[8] and 
[9]. 

 

I - Frequency domain methods 

 Peak-picking method 

 Circle-fit method 

 Inverse FRF method 
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II - Time domain methods 

 Least-squares time domain method 

 Ibrahim time domain (ITD) method 

 Random Decrement (RD) method 

 ARMA Time Series method 

 Least-squares Complex Exponential (LSCE) method 

 

III - Analysis methods 

 Least-square method 

 Dobson’s method 

 

The Fourier Transformation or Fourier Transform is a very 

fundamental mathematical instrument of signal analysis. 

Originally developed by Fourier for the solution of 

differential equations in the area of heat conduction, it soon 

was applied to totally different problems throughout the 

various disciplines of science and engineering. Initially 

developed as an analytical instrument and therefore 

constrained to the application to analytically defined and 

integrable functions, the real power of the Fourier Transform 

could only be exploited with the advent of modern 

computers. 

 

Andrew S. Elliott, Mark H. Richardson [1] have 

introduced a new method for simulating an Experimental 

Modal Analysis (EMA) using a combination of two 

commercially available software tools, ADAMS and 

ME’scope and named this new simulation method Virtual 

Experimental Modal Analysis, or VEMA. The primary 

advantage of this completely analytical approach is that many 

important questions regarding modal testing of very complex 

structures can be addressed before the actual testing is done. 

Brian J. Schwarz, Mark H. Richardson [2],gives a review 

on all the main topics associated with experimental modal 

analysis, including making FRF measurements with a FFT 

analyser modal excitation techiniques and modal parameter 

estimation from a set of FRFs (curve fitting). 

Peter Avitabile [3], presents a non-mathematical 

presentation of Experimental Modal Analysis, which give an 

idea on modal analysis, Frequency Response Functions, 

difference between shaker test and impact test, effect of 

window. He describes structural vibration and the use of some 

of the available tools for the solution of structural dynamic 

problems. 

Experimental modal analysis (EMA) is an accepted 

methodology for identifying modal parameters of complex 

system assemblies, but large channel counts and multiple 

references are usually required to perform a thorough modal 

survey of such structures. In these cases, modal testing can 

become very costly and time consuming. Moreover, success 

in accurately defining all the modes of interest from 

experimental data depends on a variety of factors. 

 

 How and where the excitation is applied.  

 How and where measurement data is acquired. 
 How boundary conditions or other environmental             

conditions are given. 
 

 The chances of performing a successful EMA are 

significantly improved if answers to the following critical 

questions are known beforehand: 

 What type of excitation signals should be used. 
 What analysis frequency range should be used.  
 How much frequency resolution is needed. 
 How the boundary conditions are accounted. 

 How do operating conditions, such as internally 

generated forces, excite the modes. 

 

A key advantage of the VEMA approach is that it 

simulates multi-channel data acquisition. Multiple transducer 

and excitation locations and directions can be easily 

introduced into the model. Transducer sensitivities and signal 

processing can also be simulated. All of the excitation and 

response data can be simultaneously sampled, for as many 

channels as desired at any desired rate. A set of simulated test 

data can be acquired in only a few minutes, whereas 

acquisition of the actual data in a laboratory environment 

might take hours or even days. 

 

A. Frequency Range and Resolution (FRR) 

One of the fundamental questions in any EMA is, What 

frequency range and resolution is needed to adequately 

estimate the parameters of the fundamental modes. 

In many real EMAs, the easiest way to answer this question is 

to impact the structure with an instrumented hammer, 

measure a few Frequency Response Functions (FRFs), and 

examine the FRFs for resonance peaks. Also, a preliminary 

look at the mode shapes is helpful if a sufficient number of 

FRFs are measured over the surface of the structure so that 

one shape can be distinguished from another. 

 

B. Frequency Response Function (FRF) 

The Frequency Response Function (FRF) is a 

fundamental measurement that isolates the inherent dynamic 

properties of a mechanical structure. Experimental modal 

parameters (frequency, damping, and mode shape) are also 

obtained from a set of FRF measurements. 

The FRF describes the input-output relationship between 

two points on a structure as a function of frequency, as shown 

in Fig 3.1. Since both force and motion are vector quantities, 

they have directions associated with them. Therefore, an FRF 

is actually defined between a single input DOF (point & 

direction), and a single output DOF. 

An FRF is a measure of how much displacement, 

velocity, or acceleration response a structure has at an output 

DOF, per unit of excitation force at an input DOF. 

Fig. 1 also indicates that an FRF is defined as the ratio of 

the Fourier transform of an output response ( X(ω) ) divided 

by the Fourier transform of the input force ( F(ω) ) that 

caused the output.  
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Fig. 1. Block Diagram of FRF 

 

 An FRF is a complex valued function of frequency that is 

displayed in various formats, as shown in Fig. 2. 

 

 

Fig. 2. Alternate Formats of FRF 

 
 

C. Vibration is Easier to Understand in Terms of Modes 

Fig. 3 points out a reason why vibration is easier to 

understand in terms of modes of vibration. It is a plot of the 

Log Magnitude of an FRF measurement (the solid curve), but 

several resonance curves are also plotted as dotted lines 

below the FRF magnitude. Each of these resonance curves is 

the structural response due to a single mode of vibration. 

The overall structural response (the solid curve) is in fact, 

the summation of resonance curves. In other words, the 

overall response of a structure at any frequency is a 

summation of responses due to each of its modes. It is also 

evident that close to the frequency of one of the resonance 

peaks, the response of one mode will dominate the frequency 

response. 

 

 

 
Fig. 3. Response as Summation of Modal Responses 

 

D. Fast Fourier Transform (FFT) 

Any waveform is actually just the sum of a series of simple 

sinusoids of different frequencies, amplitudes, and phases.  A 

Fourier series is that series of sine waves and we use Fourier 

analysis or spectrum analysis to deconstruct a signal into its 

individual sine wave components.  The result is vibration 

amplitude as a function of frequency, which lets us perform 

analysis in the frequency domain (or spectrum) to gain a 

deeper understanding of our vibration profile. Most vibration 

analysis will typically be done in the frequency domain. 

 Fourier analysis converts a signal from its original domain 

(often time) to a representation in the frequency domain. FFT 

representation of a mixture of Sin wave is as shown in Fig. 4. 

 
Fig. 4. FFT representation of a mixture of Sin wave 

 

II. METHODOLOGY 

A. Theoretical Route of Vibration Analysis 

The theoretical route is as shown in Fig. 4. The usual 

procedure for getting the natural frequencies and mode shapes 

is by modelling the system, followed by meshing the system, 

then followed by Eigen value analysis. 

 

Fig. 4. Theoretical Route of Vibration Analysis 
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B. Experimental Route of Vibration Analysis 

The experimental route is as shown in Fig. 5. The 

procedure for getting the natural frequencies and mode shapes 

is by modeling of the system, followed by meshing the 

system, then followed by response analysis of shaker test and 

impact test. Least square curve fitting technique is used get the 

natural frequencies and mode shapes. 

 

Fig. 5. Experimental Route of Vibration Analysis 

 

C. Modal Analysis of Cantilever Beam 

Modal analysis of a cantilever beam was done in both 

ANSYS and MATLAB and a comparison of the natural 

frequencies were done. 

 
Fig. 6. Structural View of Cantilever Beam 

 

TABLE I. DETAILS OF THE BEAM 
 

 

DIMENSIONS 

Length (l) 1000 mm 

Breadth (b) 20 mm 

Height (h) 1.5 mm 

 

 

PROPERTIES 

Elastic Modulus (E) 210 * 109 Pa 

Density (ρ) 7800 kg/m3 

Moment of Inertia (I) 5.625 * 10-12 m4 

 
Moment of Inertia, I = (b*h3)/12 

 A 3D analysis of the cantilever beam was done in ANSYS 

and the element taken was 3D-2Node 188 beam element. The 

3D-2Node 188 beam element is a 3D element with 2 nodes 

and each node is having 6 degree of freedom (DOF)(ie.. 

rotation about x,y,z axis and translation along x,y,z axis). The 

beam was divided into 10 sections of equal length, with each 

element having 2 nodes, thus resulting in a total of 11 nodes. 

At node 1 All DOFs were constrained. 

 A 2D analysis of the cantilever beam was done using 

MATLAB program. The beam was assumed to have only 2 

DOFs per node (ie.. rotation about z-axis and translation along 

y-axis) The beam was divided into 10 sections of equal length. 

Thus each element is having 2 nodes and so a total of 11 

nodes where required. Since each node is having 2 DOFs, so 

the total DOF of the system was 22. At node 1 all DOFs were 

constrained. 

D. Modal Analysis Using Ansys 

Procedure is as follows: 

Step 1: Pre-processor→ Element type→ Add→ Beam→ 

2node188→ OK 

Step 2: Pre-processor→ Modelling→ Create→ Keypoints→ 

In Active CS 

 X= 1 

 Pre-processor→ Modelling→ Create→ Lines→ 

Straight Line→ OK 

Step 3: Pre-processor→ Meshing→ Mesh Tools→ Set 

Lines→OK 

 Number of element division = 10 

 Mesh Tools→ Mesh→ OK 

Step 4: Plot Ctrls→ Numbering→ Node Numbers→ On→ 

OK 

Step 5: Pre-processor→ Material Properties→ Material 

Models→ Structural→ Linear→ 

 Elastic→ Isotropic 

 Elastic Modulus  =  210 * 109 

 Poissons Ratio  =  0.3 

 Density   =  7800 

Step 6: Pre-processor→ Sections→ Beam→ Common 

Sections→ 

 Breadth = 20 * 10-3 

 Height  = 1.5 * 10-3 

 Apply→ OK 

Step 7: Solutions→ Define Loads→ Apply→ Structural→ 

Displacement→ On Nodes→ Select Node 1→ OK 

 DOFs to be constrained→ All DOF 

 Value of Displacement = 0→ OK 

Step 8: Solution→ Analysis Type→ New Analysis→ 

Modal→ OK 

Step 9: Solution→ Analysis Type→ Analysis Options→ 

 Mode Extraction Method→ Block Lanczos 

 Number of Modes to extract  = 10 

 Number of Modes to expand  = 10 

Step 10: Solution→ Solve→ Current LS→ OK 
Step 11: General Postproc→ Result Summary 

 

E. Modal Analysis with MATLAB 

Program is as follows: 

 
% Variable descriptions: 

% nel = number of elements 

% nnel = number of nodes per element 

% ndof = number of dofs per node 

% nnode = total number of nodes in system 

% sdof = total system dofs 

% el = elastic modulus 

% b = breadth 

% h = height 

% xi = moment of inertia of cross-section 

% rho = mass density 

% tleng = total length of beam 

% leng = length of each element 

% area = cross-sectional area 

% k = element stiffness matrix 

% m = element mass matrix 
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% kk = system stiffness matrix 

% mm = system mass matrix 
 

% index = a vector containing system dofs 

associated with each element 

% bcdof = a vector containing dofs 

associated with boundary conditions 

% bcval = a vector containing boundary 

condition values associated with  

the dofs in 'bcdof' 

 

clear  

clc  

 

format long; 

nel=10; 

nnel=2  

ndof=2 

 

nnode=(nnel-1)*nel+1;  

sdof=nnode*ndof 

 

el=210e9;  

b=20e-3;  

h=1.5e-3;  

xi=(b*(h^3))/12  

rho=7800; 

 

tleng=1  

leng=tleng/nel;  

area=b*h;  

bcdof(1)=1;  

bcdof(2)=2; 

 

kk=zeros(sdof,sdof);  

mm=zeros(sdof,sdof); 

index=zeros(nnel*ndof,1); 

 

 

 

for iel=1:nel 

index=feeldof1(iel,nnel,ndof);       

% extract system dofs associated with 

element  

[k,m]=febeam1(el,xi,leng,area,rho,1); 

% computes element stiffness & mass 

mtrix  

kk=feasmbl1(kk,k,index); % assemble 

element stiffness matrices into 

system matrix  

mm=feasmbl1(mm,m,index); % assemble 

element mass matrices into system 

matrix  

end 

 

[kn,mn]=feaplycs(kk,mm,bcdof); % apply 

the boundary conditions.  

fsol=eig(kn,mn); % solve the matrix 

equation and print  

fsol=sqrt(fsol);  

freqhz=fsol/(2*pi);  

sort(freqhz) 

 

Functions written in the above programme are feeldof1, 

febeam1, feasmbl1, feaplycs. 

 

 feeldof1 function is defined as follows: 

 
function [index]=feeldof1(iel,nnel,ndof)  

% Purpose: Compute system dofs associated 

with each element in one dimensional 

problem  

% Variable Description:  

% index - system dof vector associated 

with element "iel"  

% iel - element number whose system dofs 

are to be determined  

% nnel - number of nodes per element  

% ndof - number of dofs per node 

 

edof = nnel*ndof;  

start = (iel-1)*(nnel-1)*ndof; 

 

for  

i=1:edof  

index(i)=start+i;  

end 

 

 febeam1 function is defined as follows: 
 

 

function [k,m]=febeam1(el,xi,leng,area,rho,ipt)  

% Variable Description:  

% k - element stiffness matrix (size of 

4x4) 

% m - element mass matrix (size of 4x4)  

% el - elastic modulus  

% xi - second moment of inertia of cross-

section  

% leng - element length 

% area - area of beam cross-section  
% rho - mass density (mass per unit 

volume)  

% ipt = 1: consistent mass matrix 

 

% stiffness matrix 

 
c=el*xi/(leng^3);  

 

k=c*[(12)    (6*leng)   (-12)      (6*leng); 

     (6*leng)(4*leng^2) (-6*leng) (2*leng^2); 

     (-12)   (-6*leng)  (12)      (-6*leng); 

     (6*leng)(2*leng^2) (-6*leng) 

(4*leng^2)]; 

 

 

% consistent mass matrix 

 

if ipt==1 

 

mm=rho*area*leng/420; 

 

m=mm*[(156)    (22*leng)  (54)    (-13*leng); 

      (22*leng)(4*leng^2)(13*leng)(-3*leng^2); 

      (54)      (13*leng) (156)   (-22*leng); 
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     (-13*leng)(-3*leng^2)(-22*leng)(4*leng^2)]; 

end 

 feasmbl1 function is defined as follows: 
 

function [kk]=feasmbl1(kk,k,index) 

% Purpose:Assembly of element matrices 

into the system matrix 

% Variable Description:  

% kk - system matrix  

% k - element matri  

% index - d.o.f. vector associated with 

an element 

 

edof = length(index);  

for  i=1:edof  

ii=index(i);  

for  j=1:edof  

jj=index(j);  

kk(ii,jj)=kk(ii,jj)+k(i,j);  

end  

end 

 

 feaplycs function is defined as follows:  

 

 

function [kk,mm]=feaplycs(kk,mm,bcdof) 

% Purpose:Apply constraints to eigenvalue 

matrix equation  

% [kk]{x}=lamda[mm]{x} 

% Variable Description:  

% kk - system stiffness matrix before 

applying constraints  

% mm - system mass matrix before applying 

constraints  

% bcdof - a vector containging constrained 

d.o.f 

n=length(bcdof);  

sdof=size(kk);  

for  i=1:n  

c=bcdof(i);  

for  j=1:sdof  

kk(c,j)=0;  

kk(j,c)=0;  

mm(c,j)=0;  

mm(j,c)=0;  

end  

mm(c,c)=1;  

end 

 In short, our system is a cantilever beam (Euler Bernoulli 
beam) of 1m long, which is uniformly meshed into 10 equal 
parts and each element is having 2 nodes. So there are a total 
of 11 nodes in the system. We assumed 2 Degrees of Freedom 
(DOFs) per node(translation along y-axis and rotation about z-
axis), therefore each element Degrees of Freedom is 4 and the 
system Degrees of Freedom is 22. This means that the size of 
both element stiffness matrix and element mass matrix are 
(4x4) and thae size of system stiffness matrix  and system 
mass matrix are (22x22). Our task is to assemble the ten 
element matrices of size (4x4) into a single system matrix of 
size (22x22) and also to constrain all degrees of freedom at 
node 1. The above code is applicable for any value for 

dimensions of the beam and also applicable for any number of 
elements. 

Element Stiffness Matrix (k) =    

 

Where  E = el = 210 * 109 Pa 

 I = xi = 5.625 * 10-12 m4 

 l = leng = 0.1 m 

 

Element Mass Matrix (m) =   

 

 

Where  ρ = rho = 7800 kg/m3 

 A = area = 3 * 10-5 m2 

 l = leng = 0.1 m 

 

therefore, 

 

 = 1181.25 N/m 

 

 = 5.571 * 10-5 kg 

k =  1181.25 *  

 

m =  5.571*10-5 *  

 

System Stiffness Matrix, kk = 1181.25 * 
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System Mass Matrix, mm = 5.571 * 10-5 * 

 

 

III. RESULTS 

A. Results obtained in ANSYS 

 

I. First Mode Shape is as shown in Fig. 7. 

 

 
Fig. 7. First Mode Shape 

 
 

II. Second Mode Shape is as shown in Fig. 8. 

 

 
Fig. 8. Second Mode Shape 

III. Third Mode Shape is as shown in Fig. 9 

 

 
Fig. 9. Third Mode Shape 

 

The first three natural frequencies obtained in ANSYS is 
as follows: 

 f1 = 1.2573 Hz 

 f2 = 7.8792 Hz 

 f3 = 22.062 Hz 
 

B. Results obtained in MATLAB 

 

The first three natural frequencies obtained in MATLAB 

is as follows: 

 

 f1 = 1.25728645 Hz 

 f2 = 7.87953378 Hz 

 f3 = 22.0678097 Hz 

C. Comparison of the results 

A comparison of the first three natural frequencies IN Hz 

obtained from both ANSYS-16 and MATLAB 2008 is as 

shown in Table 2. 
 

TABLE II.  FIRST THREE NATURAL FREQUENCIES 
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IV. CONCLUSION 

 Modal analysis of a Cantilever beam was done in both 
ANSYS-16 and MATLAB 2008 and the first three natural 
frequencies obtained in both the platforms are almost same. 
Hence the MATLAB code is validated. 
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